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I. INTRODUCTION

The Green Chemistry Expert System (GCES) was designed to be used to identify
opportunities to eliminate or reduce the use of hazardous chemicals and the production of
hazardous waste. The GCES is comprised of five modules:

Synthetic Methodology Assessment for Reduction Techniques (SMART) -- a
program designed to quantify and categorize hazardous material used or
generated as the result of a manufacturing process;

Green Synthetic Reactions -- a searchable database of synthetic processes that
identify alternative processes to replace a more hazardous materials with a less
hazardous ones;

Designing Safer Chemicals -- an information module detailing the design of safer
chemicals; especially useful in this module is check list to determine eligibility
for the Agency’s polymer exemption from reporting requirements under the Toxic
Substances Control Act (TSCA).

Green Solvents/Reaction Conditions Database -- an information module
detailing green solvents and reaction conditions, a database containing a list of
solvents with selected physical/chemical data for use in identifying solvent
substitutes.

Green Chemistry Reference Sources -- a searchable database containing
literature references for the four modules as well as other Green Chemistry
references.

Taken together, the modules of the GCES provide a source of information on Green
Chemistry that may be used as an effective pollution prevention tool. The GCES was initially
developed by Syracuse Research Corporation (SRC) under contract with the Office of Pollution
Prevention and Toxics (OPPT) of the U.S. Environmental Protection Agency (EPA).

The current version being distributed is version 0.99. The SMART module is fully
operational. The other modules are operational and are still being developed. EPA would
appreciate feedback on both the content and ease of use of the system. Please address your

comments to:

Richard Engler, PhD or Carol A. Farris, PhD
Green Chemistry Program
Industrial Chemistry Branch (7406M)
U.S. Environmental Protection Agency
Office of Pollution Prevention and Toxics
1200 Pennsylvania Ave., NW
Washington, DC 20460
Telephone: (202) 564-8740
greenchemistry@epa.gov

DISCLAIMER



The Green Chemistry Expert System is part of EPA's Green Chemistry Program, a
voluntary pollution prevention initiative that promotes the research, development, and
implementation of green chemistry technologies. The System is a software package designed to
provide users with information and tools to make new or existing manufacturing processes less
hazardous to human health and the environment. Use of the GCES does not exempt the user
from any regulatory responsibilities. The GCES should not be used for reporting or other
regulatory activities.

Il. SYSTEM REQUIREMENTS

The GCES is designed for use with Microsoft Windows™ version 3.1 or higher. It
requires a color monitor and the capability of displaying a minimum of 16 colors. The GCES
must be run on a drive for which you have write permission and requires approximately 20
megabytes of disk space for complete installation, although it can be installed with as little as 5
megabytes using the minimal installation option. The minimal installation option requires an
additional 15 megabytes on another disk, such as a removable-media drive, for the external
databases. You do not need write permission for this space. It is recommended that you have at
least 8 megabytes of RAM available on your computer, otherwise some parts of the GCES may
be sluggish. A mouse is required for ease of use of the system. Using the system with minimal
installation requires that the drive to which the external databases were installed be present.

In addition, installation of the GCES requires an additional 20 megabytes of disk space.
Once installation is complete, this space can be freed up by deleting the installation files. The
GCES is not designed for network use.



I11. INSTALLATION

The GCES was developed using Microsoft Access® version 2.0, a relational database
management system developed by Microsoft Corporation (Copyright © 1994). The GCES is
operated using the Runtime version of Access®, a stand-alone version of the program designed
to perform custom applications developed using Access®. Microsoft Access® Runtime is
installed on your computer with the same installation disk as the GCES application software and
is provided to you for the exclusive purpose of running the GCES. Microsoft Corporation
reserves all copyright protection of Access® Runtime worldwide.

The current version of the GCES is provided for download from EPA’s Green Chemistry
web site: http:\\www.epa.gov\greenchemistry. After downloading, locate the self-extracting
archive file gcesinst.exe on your hard drive using the Program Manager or Windows Explorer
and double-click on it. This will extract the setup files needed to install the GCES into the
directory c:\gcesinst. Once the extraction is complete you may delete gcesinst.exe. Run the
setup program by selecting File, Run from the Program Manager (Windows 3.x) or Start, Run
(Windows 95) and entering c:\gcesinst\setup.exe in the command line box that appears. The
setup program creates the appropriate directories for you and copies the program files to your
hard drive. A copy of this manual can be found in c:\gcesinst\imanual.pdf. You may cancel the
installation at any time, but if you do so, rerun the entire installation process to ensure all
components are installed correctly. You should not need to rerun the extraction process.

You will be asked to confirm the drive and directory where the files will be installed (the
default is c:\gces). The final screen in the installation program will display the settings chosen
and wait for your confirmation (Figure 1). To continue installing the GCES, click on the large
computer icon. The files will then be copied to the specified drive. It is recommended that you
install GCES on an internal hard drive. You may load the system to a removable drive, but
performance may suffer because of slow data-access times.

Green Chemistiy Expert System Setup

Begin the installation by clicking the large button.

Complete
Inztall all filez for thiz application

Directory:
[ C:AGCES | Change Directory._. I

| Exit Setup I | Help I

Figure 1: GCES System Setup Screen

After the initial installation, you will see the Installation Options Screen (Figure 2). At



this point, you must decide if you are going to load the large data tables (approximately 20
Mbytes) on to your computer. You may choose to save the large data tables to your hard drive
or a removable drive. If you choose to load the data tables to your hard drive, select “Copy the
supplemental databases to the GCES directory”. If you choose to load the data tables to another
location, select “Copy the databases to:” and enter a path (drive and directory) where you want
the tables saved. Click Continue to complete the installation. If you cancel this phase of the
installation, rerun the entire installation to ensure that all components get installed correctly.

Green Chemistry Expert System

Installation Options

The GCES contains two large supplemental databases that
use approximately 20 megabytes {20 MB) of disk space.
These databases can be loaded onto the same directory
as the GCES main program or to another location.

C' Copy the supplemental databases to another directory
Fath:

® Copythe supplemental databases to the GCES directony

Directory path the installation was started fram: IC:"-,GCESINST

Cancel Installation

Figure 2: Installation Options Screen

If, after the initial installation, you may want to change to the other installation option,
you can do so manually. You can move the database files lookup.mdb and greenref.mdb to
another location using File Manager or Windows Explorer, just be sure to keep them both in the
same directory. After you have moved these files, be sure to change the path for external tables
in the GCES preferences (see Figure 5) to the new directory containing the database files.



IV. STARTING THE GCES

For purposes in this manual, it should be noted that the terms “select”, “choose”, and
“click” are used interchangeably and simply mean for you to press the left button on your mouse
to select the item of choice. To facilitate the understanding of the GCES program options, menu
items and push-buttons are highlighted in bold in this manual. Please note that the graphics
appearing in this manual were developed using Windows95 and some screens may appear
slightly different to Windows 3.x users.

To access the GCES program in Windows 3.x, double-click on the icon that the install
program created in the GCES program group. Windows95 users can select Start, Programs,
Green Chemistry Expert System, GCES. The program will load and you will see the GCES
startup screen (Figure 3).

Green Chemistry Expert System

Industrial Chemistry Branch
Office of Pollution Prevention and Toxics
U.S. Environmental Protection Agency

Developed under contract by Syracuse Research Corporation
“ersion 0.99

Figure 3: GCES Startup Screen

Note the menu bar at the top of the screen. This menu bar contains information on the
items available to choose from at each point in the program. For example, when the startup
window is on the screen, you can choose the Continue button from that window, or you can
click on File in the top left corner and select Continue from the File menu. After you select
Continue, the GCES main menu will appear with the list of available program modules
(Figure 4). Select the module you wish to use from this list or from the top menu bar under
Module. Each of these modules is described in Section VI of this manual.

To exit the GCES, return either to the GCES Startup Screen (Figure 3) or the GCES
Main Menu Screen (Figure 4) and then select File, Exit from the menu. You will be prompted
to confirm that you want to exit the GCES application. You may also click on the Exit button on
the Startup Screen, but you will not be prompted for confirmation.



Welcome to EPA's

Green Chemistry Expert System

:Synthetic Methodology Assessment;
for Reduction Technigues (SMART) :

Green Synthetic Reactions

Designing Safer Chemicals

Green Solvents\Reaction Conditions

Green Chemistry References

Figure 4: GCES Main Menu Screen

Preferences Menu
The preferences should be automatically set during installation. However, if you install
components later on, or if you move components, you may need to change the preferences by
selecting Preferences from the File menu. The preferences screen will come up (Figure 5). The

LS S S S

Path for external tables:

|chgces

Path for befwin.exe:

Path for biowin.exe:

||::'xest

Path for ecowin_exe:

|n::'~.est

| Ok Cancel

Figure 5: Preferences Screen



first entry, “Path for external tables™, is the directory where the two external data tables,
lookup.mdb and greenref.mdb, are stored: on your hard drive or a removable. You can check the
location of these files using File Manager or Explorer. The other three paths are for links to
estimation software, bcfwin (bioconcentration factor), biowin (biodegradation), and ecowin
(ECOSAR - aquatic toxicity). These are not necessary to run the GCES, the links are provided

> Green Chemistry Expert System | [O] %]
File Edit Bookmark Options Help
Ennlentsl §earch| Bach | Print |
Green Chemistry Expert System i’

The Green Chemistry Expert System consists of several modules covenng different aspects
of envwironmentally Fendly chermistry. To choose a module, click on the corresponding button on
the screen.

Svnthetic Methodology Assessment for Beduction Technologies (SMART)
This module contams a program designed to assess the environmental impact of a given process.

This program calculates and categonzes the wastes generated i a process and mdicates the
Enwironmental Protection Agency's level of concern ansing from the results.

Green Synthetic Reactions
The Green Synthetic Reactions module 15 a databasze containing examples of selected synthetic

processes. These processes have been chosen as examples of green chernstry alternatives to
replace standard mdustnal syntheses. The user can search the database by pollution prevention
cotnments (e.g., safety, inexpensive), key word(s), statuz (e.g, lab scale, pilot plant, patent), or
reference. Fesults are presented on a form that contains the full reference citation(s), a
description of the reaction, the status, and comments on the pollution prevention advantages for
each process. To retneve all the examples, enter an asteriz (*) in the reference field.

i WOV RN TR - POV JOT o1 NS JOP, P LI

Figure 6: GCES Help Screen

for users who have these estimation programs. For more information, see the Designing Safer
Chemicals module in section VI.C.

V. RUNNING HELP IN THE GCES

You can access the help program that supports GCES at any point in the program by
clicking on Help on the menu bar at the top of the screen or by pressing the F1 key. The GCES
uses context-sensitive help: the help topic is related to the module you are working in. For
example, if you are in the Green Solvents/Reaction Conditions module, clicking on Help will
display information on that particular module. You may, however, see the contents of all of the
topics in the help program by clicking on Contents in the Help Screen (see Figure 6). From this
help screen, you may access any of the topics. To print a help topic, select File, Print from the
menu bar at the top of the help screen or select Print from the lower menu bar.

To exit help, either select File, Exit on the help screen menu bar, or, with Windows 95
click on the “x” in the top right corner of the help screen, and you will return to the point in the
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GCES program where you accessed help.

VI. RUNNING THE GCES MODULES
A. Synthetic Methodology Assessment for Reduction Techniques (SMART)
1. Description of the Module

Since 1993, the SMART assessment has been part of the Agency’s review of
Premanufacture Notifications (PMNs) received under the Toxic Substances Control Act (TSCA).
The program was initiated by the Agency to alert PMN submitters to possibilities for reducing or
eliminating the use or generation of hazardous substances during the manufacture of new
chemicals (i.e., to identify and pass on opportunities for pollution source reduction). It is the
Agency’s hope that the non-regulatory, voluntary suggestions made by Agency chemists will
encourage chemical manufacturers to review their manufacturing processes and reduce the
hazardous materials related to these processes.

The primary purpose of the SMART module is to help chemical manufacturers
understand how the Agency performs its internal SMART reviews and to make this tool
available so that manufacturers can perform similar analyses during the course of chemical and
process research and development, prior to filing a PMN with the Agency. The SMART
assessment techniques are, however, applicable to both new and existing substances. Secondary
purposes of the system include helping manufacturers of existing chemicals to identify and
reduce the use and production of hazardous materials and supporting academic institutions in the
training of chemists in source reduction.

The source reduction opportunities identified by the SMART module may include such
things as the need to identify benign chemicals as replacements for hazardous starting materials
or the goal of changing a synthesis to prevent the formation of hazardous or unusable byproducts
or coproducts. In addition, a search for green reaction conditions may be suggested to eliminate
the use of hazardous solvents or improve the efficiency of the reaction, thereby increasing
conversion of feedstocks and reagents and increasing product yield and atom economy.
Successful source reduction strategies benefit the environment by reducing the amount of
harmful and potentially harmful chemical wastes that may be released, and may benefit the
manufacturer through potential savings through reductions of starting materials and waste
disposal. The SMART module, however, only examines the chemicals directly involved in the
manufacturing process of a commercial product. There are other potential environmental
concerns that are not considered by the SMART assessment; for example, the use of an oil
burner to heat a chemical reaction, even a “green” reaction, may give rise to other pollution that
is not addressed by the SMART module.

It is important to note that the GCES is a tool. It cannot judge the relative merits of
processes. It can aid you in identifying some of the potential problems associated with a reaction
and potential alternatives. It requires that you make a reasoned judgement about the relative
merits of the approaches found. An alternative may still trigger concerns even though it is the
best alternative.

The SMART module of the GCES allows you to analyze the amount of chemical waste
produced by a manufacturing process. In addition, the module classifies the chemicals according



to their hazard (using EPA criteria) and displays general concerns for these chemicals, allowing
you to target specific chemicals for reduction or elimination from the synthesis. By identifying
green alternatives to your initial process and entering them into the SMART module, (e.g.,
changing the amount of material recovered or using less hazardous feedstocks and reagents), you
can repeat the analysis to observe changes and reduce or eliminate the use and creation of
hazardous materials. The Agency realizes that changes in chemical syntheses made for source
reduction must be both chemically and economically feasible. The SMART module may lead to
the development of a green synthesis, but the user must ultimately determine the economic
reasonableness of any new synthesis, including such things as the cost of feedstocks and other
reagents, yield, equipment modifications, energy use, etc.

The SMART module contains mathematical algorithms that perform a series of
calculations for a given reaction process. This module performs mass balance calculations based
on user-entered data and classifies the hazardous nature of each material used or formed in the
process, using established EPA guidelines. You will be asked for some general information
regarding your reaction process:

. the reaction identity or name (“Reaction 1D”);
. the typical number of batches per year; and,
. the expected percent yield of the reaction.

You should also be prepared to provide the following information for each chemical used
or formed in the process:

. CAS Registry Number (CAS RN), if known;

. the kg/batch charged or formed,;

. the kg/batch recovered,

. the role of the chemical in the reaction (e.g., feedstock, product, solvent, etc.); and
. the number of equivalents required or formed (this information is not needed for

catalysts, solvents, impurities, and byproducts).

Use a CAS RN if you know it. The GCES includes a Lookup Table with basic
information on over 60,000 chemicals listed by CAS RN (note: this list is not reflective of TSCA
inventory). If the CAS RN you enter is in the database, the GCES automatically looks up:

. the chemical name;
. the molecular weight; and,
. the SMILES notation (i.e., the chemical structure).

If a chemical in the manufacturing process does not have a CAS RN, you will also need to enter
a unique alphanumeric identifier for the chemical so that the system can store information on this
chemical for your use later.

The SMART module uses Simplified Molecular Input Line Entry System (SMILES)
notation to represent molecular structures by strings of symbols. Discussion of SMILES
notation is outside of the scope of this document. You should consult Weininger’s original paper
on this topic (Weininger, D., J. Chem. Inf. Comp. Sci. 1988, 28(1), 31) if you are unfamiliar with
this notation. An expanded discussion on SMILES notation is also available on the World Wide



Web at http://esc.syrres.com/~ESC/docsmile.htm. Some chemistry drawing packages (such as
ChemDraw, ConSystant, Kekule) will generate a SMILES notation from a chemical structure.
For certain chemical structures (primarily salts and inorganics), the standard SMILES notations
have been modified in the SMART module to be compatible with other Syracuse Research
Corporation products. Entering a standard SMILES notation for one of these classes of
molecules will result in an error message even though the SMILES notation is correct. When
prompted if you want to edit the notation, click on No and proceed as prompted. The SMART
analysis may not be able to recognize the functional groups in that molecule, so it may not be
able to classify the hazard tier correctly. However, the calculations will proceed normally.

After the SMART data entry is complete, the program will analyze all the wastes
produced in the reaction and provide you with the total amount of waste produced (in kg/year
and as a percentage of the total annual production volume), separated into four hazard categories
which we call Tiers 1 through 4. To assist you in interpreting the results, the program will
provide a qualitative indication of the level of concern that is triggered by the reaction process.
If chemicals in Tiers 1 or 2 are present, the program will direct you to the other modules as
appropriate.

Please note that the algorithms developed for this module have been designed for and
tested with single-step reactions that produce a single discrete chemical product. The program is
not appropriate for polymers or reactions with multiple products. The individual reactions of a
synthetic sequence may be run sequentially. Simply enter the recovered mass of product for
each step as the amount of feedstock charged in the subsequent reaction.

2. Starting the SMART Module

When you choose the SMART module from the main system menu, the SMART module
menu will appear (Figure 7).
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Welcome to the GCES SMART Muodule

This system 15 designed to provide users with information
and tools to make new or existing manufacturing processes
less hazardous to human health and the environment. Use
of the system does not exempt the user from any regulatory
responsibilities. It should not be used for reporting or
regulatory achtivities.

il understand, proceed to SMART Assessment!

Ahout the SMART Assessment

Return to Main Menu

Figure 7: SMART Menu Screen

11



To learn more about the SMART module, click on About the SMART Assessment.
You will then see the first information screen: “What is the SMART Program for Pollution
Prevention?” (Figure 8) From there, you can continue looking at other topics by clicking on
SMART on the top menu bar and selecting a topic of interest, or you can return to the SMART
Menu Screen (Figure 7) by clicking on File, Close.

&l Microsoft Access _ 2]
. What iz the SMART Program for Pallution Prevention? ;
- “What iz the EPA's Mew Chemical: Program’? .
Hos v How Does the SMART Relate to Pollution Prevention? —
— “What iz the Gaoal af the SMART Pragram? o

The  HowDoes EPA Meet This Goal? prevention ethic and provides an
9PE  How Does the EPA Select PMN Submissions for SMART Review pu prevention goals. Voluntary
Pl o Doss EPA Perform Prefiminary Pollution Prevention Review? s or, as in the case of the SMART
Pro : i y Pollution .reven ion Feview? jcals Program of TSCA.

How are Chemicals Clazsified for SMART Review?
The Haw are Chemicals |dentified and T argeted? P& states that
"Tk How is the Quantity of Each Chemical Substance Determined? tes that pollution should be
[t Haw Dioes the Agency Decide Whether ta Perfarm a Detalled Beview? be prevented should be recyeled in
Mt How Does EPA Perfarm Detailed Pollution Prevention Assessments? p prevented or recycled should be
28 o Does EPA Notify PMN Submitters of the Results? o ol ulith flae Gasnlioausil
shao . rironmentally safe manner"

Haw Can | get Mare |nfarmation?

Houtce reduction is defined, in patt, as

"atry practice which... reduces the amount of aty hazardous substance, pollutant, or contaminant entering angy
waste streatn of otherwise released into the enviromment (including fugitive emizsions) priot to recycling,
treattment, of disposal; and.. teduces the hazards to public health and the etvirorunent associated with the
telease of such substances, pollutants, or contadnants."

"Wheteas the New Chemdeals Program assesses tisks that thay be pozed by the niew chemdcal substance itaelf
the SMART Program reviews the complete marmfacturing process used in making the new chemdcal looking at

SMART Tutarial | I I [NUM |

Figure 8: About the SMART Assessment Screen
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3. Entering Reaction Data

To perform a SMART assessment on a new or saved chemical reaction, read the disclaimer
and choose | understand, proceed to SMART Assessment from the SMART Menu Screen
(Figure 7). You must then enter basic reaction information, either by typing it into the system (for
a new assessment) or by calling it up from the program memory (for a saved assessment). To
begin a new assessment, you must enter a unique name in the Reaction ID field and provide the
following process information: number of batches/year and percent product yield [i.e., (actual
total mass of product formed/theoretical maximum amount of expected product) x 100]. If you
only know the percentage of product recovered, enter that percentage for the reaction yield. When
you are finished, click on the Continue button at the bottom of the screen (see Figure 9).

To perform a new SKAET

assesstnent, please provide the it I
reaction data then clicl: "continue" Eatchesivear:
to add the chemical-specific
Sl Eeaction Yield ()
Close Form Open Saved Reaction Continue I
Reacton Id: Open
*
- Cancel
— | Cancel |
Aample 2

Figure 10: Open Saved Reaction Screen

To call up a saved reaction, click the Open Saved Reaction button or pull down the File
menu and select Open Saved Reaction. The reaction ID box will appear; clicking on the down
arrow will produce a list of saved reaction identities for you to choose from. Then click on the
reaction ID of your choice (Figure 10).

Two sample reactions are provided with this GCES distribution. The examples in this
manual use the data in Sample 1. The chemical reaction and associated data for Sample 1 are
shown in Figure 11. The associated reaction information screen is shown in Figure 12.
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CAS Chemical Name Role* | Egq** Amount Amount
Registry CAS Name [trivial name] Charged or | Recovered
Number Formed per | per Batch

Batch (kgs) (kgs)

75-04-7 | Ethanamine [ethyl amine] F 2 3,607 0

75-44-5 | Carbonic dichloride [phosgene] F 2 4,946 0

80-05-7 | Phenol, 4,4'-(1-methylethylidine) F 1 4,566 0

bis
[bisphenol A]
108-88-3 | Methylbenzene [toluene] 10,000 8,000
7647-01-0 | Hydrochloric acid C 4 2,880 0
product | product P 1 7,409 6,500

* F = Feedstock; S = Solvent; C = Coproduct; P = Product; ** Equivalents
Reaction proceeds with 87.7% yield. Produce 2 batches per year.

|
O O O
HO OH

+2 I

Cl Cl
l - 4 HCI

O O
~FAT T

Figure 11: Sample 1: Chemical Reaction and Associated
Data.
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After editing click , . —m
"continue” to return to the Reaction ID -
chemical-specific information. Batchesiyear: o
Eeaction Yield (%) 817
Close Form Open Saved Reaction Continue I

Figure 12: Reaction Information Screen: Sample 1

Please note that once you enter a reaction 1D, you may save the reaction at any time by
selecting File, Save or File, Save As from the menu at the top of the screen.

Clicking on Continue when you are finished with the reaction information screen brings
up the summary screen showing your chemical-specific data (Figure 13). At this point, you need
to enter all of the chemical substances used or formed during the manufacturing process (if they
have not been entered and saved previously).

GCES SMART Module
Id: Sample 1 Yield: 100 X Batches : 2 “olume [kg) ;13000
m Coproduct Hyrdrochloric acid
00007 5-04-7 Feedstock Ethanamitie
00007 s-44-5 Feedstock Cathonic dichlonde
000020-05-7 Feedstock Fhetol, 4471 -methylethilideneibis-
Froduct Product Froduct
000108-85-3 Solvent Eenzene, methryl-
M| 4| Fecord:|1 af B L L 4 L
Entry: | Add | | Edit || Delete ||| Edit Reaction Data | [ SMART Review |
Rxn: | New I | Open I | Save I | Return to Main Menu I | Print Reaction I

Figure 13: Chemical Summary Screen
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> To Add a Substance to a Reaction

Begin by selecting Entry: Add from the Chemical Summary Screen (Figure 13) and
providing information on the chemical you wish to add. You will be prompted to enter a chemical
identifier (Figure 14): either a CAS Registry Number or another unique identifier if you do not

have a CAS RN. Itis to your advantage to find and use a CAS Registry Number for each chemical
in the reaction, if one exists.

Enter Chermical 1T

| ®  CAS Registry Number
C' Other Tnique Identifier

| Cancel Find

Figure 14: Chemical Identification Screen

You may enter CAS RNs with or without leading zeros, but they must have dashes. Click
on Find to search for the chemical in the SMART Lookup Table, a database of over 60,000
chemicals containing information on CAS RN, chemical name, molecular weight, and SMILES
notation. If the CAS RN you entered is in the Lookup Table, then the chemical name, molecular
weight, and SMILES notation will be provided on the Chemical Information Screen (Figure 15).
For example, assume that you want to add ethanamine. After you enter the CAS Registry number
75-04-7 and select Find, the Chemical Information Screen will be displayed (Figure 15). Note:
you cannot enter a chemical twice for the same reaction. If for some reason the Lookup Table,
lookup.mdb, is not found, the Preferences Screen (Figure 5) will pop up. Check the path for the
external databases and try the data entry again.

CAS Registry Mumber:  000075-04-7 ILAE 45.08
SMILES: WCT
MNarne: M
ity (kgs): I Oty Eecowvered IEI
Eole: IFeedstock |i| Ecivalents: I
| Cancel | Continue |f@)

Figure 15: Chemical Information Screen

Once the chemical information is displayed, fill in the quantity used or produced in the
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process (kg/batch), equivalents (from the stoichiometry of the reaction), amount recovered
(kg/batch), and the role the chemical plays in the process (select from the drop-down list). For the
purposes of the SMART analysis, a reaction can only have one product. Other compounds that
are formed during the reaction are identified either as coproducts or byproducts.

Coproduct - any chemical that is expected and necessarily generated as a result of the
synthesis of the desired product. (For example, the production of methanol in the hydrolysis of a
methyl ester.)

Byproduct - any chemical that is unexpectedly formed in addition to and usually at the
expense of the desired product. (For example, production of a diester from a diacid and an alcohol
when the desired product is the mono ester.)

Note: This definition of a byproduct differs from the definition in the PMN rules (40 CFR
720.3d 1990): “*Byproduct” means a chemical substance produced without separate commercial
intent during the manufacture, processing, use, or disposal of another chemical substance or
mixture.” The definition used in the PMN rules could include both coproducts and byproducts as
defined for the GCES.

For products and coproducts, you may select “autocalc” instead of providing a quantity
formed. When autocalc is active, the SMART module will calculate the amount of the substance
formed during the reaction using the yield that was entered in the Reaction Information Screen
(Figure 9). Itis strongly recommended that you use autocalc for coproducts. It is also a useful
feature if you only know how much product is recovered from the reaction and not how much is
formed.

ID not found?

ID Number; 001111-11-1 was not found in the
lookup table.

YWould vou like to continue?

Figure 16: CAS Registry Number Not Found Screen

If the CAS RN is not found in the Lookup Table (or you do not provide a CAS RN), you
will get a message that the substance was not found in the Lookup Table and you will be asked if
you would like to continue (Figure ?). Clicking on No will return you to the chemical ID screen
(Figure 14). You might want to do this if you realize that you entered a CAS RN incorrectly and
want to edit it. After correcting the CAS RN on the chemical ID screen, select Find to continue.

If you select Yes, you will have to enter the information on molecular weight, chemical
name, and SMILES notation to the blank Chemical Information Screen (Figure 17). Click on Add
above information to lookup table to save this chemical and its associated information for
automatic retrieval in the future. You do not need to add information to the Lookup Table if the
chemical will only be used for one reaction. Caution: should you need to leave the GCES to find
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ID: 001111-11-1 MW |
SHILES:
Matme:
| Add above information to lookup table
ity (kgs): Cty Eecovered (kes): |
Fole: |[Feedstock |i| Eeuivalents: I
Cancel | Continue ‘ﬂ?

Figure 17: Chemical Information Screen for Data entry

some of the information for this form, you should save your work by adding the information to the
lookup table before exiting.

If you do not have a CAS RN, you may click on the “Other Unique Identifier” box and
enter a chemical identity of your choice (numbers, letters, or both) in the chemical ID box.
Chemical name, abbreviation, trade name, notebook page, R&D code, etc. may be used as a
Unique Identifier name. If this same Unique Identifier has been previously entered into the system
and saved in the Lookup Table, the system will retrieve the molecular weight, chemical name, and
SMILES for you. If you have forgotten a Unique Identifier you used previously, you can find it in
the Userlist of Chemical Identifiers (Figure 18). Select Edit or Delete Record from Userlist
from the Maintenance menu, and using the pull-down list by the entry box.

For more information and descriptions of the data that you need to enter, click on the “?” at
any time you are using this screen, or select Help from the Help menu and read the information
under the topic “Substance Data Entry/Edit.” (See Section V above for more information on the

Choose the Chermeal 1T

| »
oooos0-11-3
[ lexra ]

| Delete Entry I

| Cancel I

Figure 18: Userlist of Chemical Identifiers Screen
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Form: Category Form ] |

Is your chemical in one of the following categories?
Acid dyes
Amphotenc dyes
Cationic dyes
Polyamonic polymers (or monomers)
Rosin
@ves ONo | [ Continue |

Figure 19: Chemical Category Screen

GCES Help function.) If the chemical added is new to the database, you will prompted to identify
its category (Figure 19). This helps the GCES classify the substance in the proper tier.

When you have entered all of the data for the first chemical on the Chemical Information
Screen (Figure 15), select Continue and you will return to the Chemical Information Summary
screen (Figure 13), where you will be able to add, edit, or delete chemicals and their associated
data. Click on Entry: Add to add the next chemical substance. You may edit a chemical entry by
selecting the chemical or by highlighting the chemical (with the mouse or the arrow keys on the
keyboard) and then clicking on Entry: Edit. You may delete entries by highlighting the chemical
and then clicking on Entry: Delete. Continue this procedure until you have entered all of the
chemicals in the process. Check to see that you have entered all chemicals, including feedstocks,
products, solvents, etc. The analysis will not be complete unless all chemicals are added, even
non-reactants.

There are a number of other commands available to you while you are using the Chemical
Summary Screen (Figure 13). In addition, these functions are available on the Reaction
Information Screen (Figure 9).
> To Save the Reaction Data

To save the reaction data, click on Save or Save As from the File menu bar at the upper
left corner of the screen.
> To Print the Reaction Data

To print the reaction data, select on Print from the File menu bar.
> To Open a Previously-Stored Reaction

To open a reaction saved earlier (including the Sample reactions supplied with the system),
select File, Open from the File menu bar or click on the Open Saved Reaction button on the
Reaction Information screen.
> To Edit Reaction Data

To edit reaction data, click on the Edit Reaction Data button at the bottom of the
Chemical Summary Screen (Figure 13). This button takes you back to the Reaction Information
Screen (Figure 9), where you may change the yield and number of batches for your reaction.
> To Edit or Delete an Entry for a Chemical Substance in the Lookup Table

To edit or delete the information for any chemical stored in user section of the Lookup
Table, select Maintenance, Edit or Delete Record from Userlist on the top menu bar, then
choose the desired chemical from the drop-down menu (see Figure 18).
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4. Running the SMART Assessment

After you have entered all the information about the reaction and its related substances, you
may perform the SMART Assessment. To perform the SMART assessment on the chemical
process, select SMART, Perform Assessment on the top menu bar or click on the SMART
Review button. The program will perform a series of mass-balance calculations and will provide
you with the waste amount and hazard classification for each chemical used or formed in the

process. The system will also provide summaries by hazard class and a qualitative level of

concern. The SMART Assessment Summary Screen (Figure 20) shows the total amounts of
materials calculated in each of the hazard tier categories as a percentage of annual production

volume.
SMART Asse
Wagte as a Percent
of Production Yolume
15.22
Tier 1
end | Tier2 117.38
Tier 3 | Tier 3 0.00
Wate 14243 | Total 132.60
- | Tier 4 0.00
Product Product ¥olume: 1. 30E+04
0 5000 10000 15000 20000 . .
kgfyear Level of Concern
0K Green Suggestions Print | EPA Hequlated
Figure 20: SMART Assessment Summary Screen

. Product: Production volume of the product chemical. This represents the amount
of chemical produced and isolated as useful product, as entered on the reaction ID
screen. This is not a waste total.

. Tier 1: Total waste for Tier 1 chemicals. Tier 1 chemicals are a small set of
chemicals that are exceptionally hazardous therefore their use or generation should
be avoided if at all possible. Examples are dioxins and phosgene (carbonic
dichloride).

. Tier 2: Total waste for Tier 2 chemicals. Tier 2 includes the chemicals on the
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Emergency Planning and Community Right-to Know Act (EPCRA) sections 302
(Extremely Hazardous Substances) and 313 (Toxics Release Inventory or TRI) lists
as well as the Clean Air Act section 112(r) and Hazardous Air Pollutants lists. In
this manual, “EPA regulated chemicals” refers to these lists only. In addition, it
includes chemicals having functional groups associated with high toxicity (e.g.,
acid chlorides, alkoxysilanes, epoxides, or isocyanates) that are derived from the
OPPT internal list of chemicals of potential concern. Some of the OPPT Chemical
Categories are very broad. As a result, not all chemicals that are in an OPPT
Chemical Category are especially toxic, but they are screened carefully by Agency
scientists as members of a Category during new chemical review. Further
information and copies of these lists may be obtained from the EPCRA and TSCA
hotlines. The EPCRA Hotline number is (800) 424-9346 or (703) 412-9810 in the
Washington, DC area; the TSCA Assistance Information Service number is (202)
554-1404 and its E-mail address is tscahotline@epa.gov.

. Tier 3: Total waste for Tier 3 chemicals. Tier 3 includes all chemicals of unknown
or intermediate toxicity. This is a broad category that includes those chemicals not
included in Tiers 1, 2, or 4.

. Waste 1 + 2 + 3: Total hazardous waste. This is the sum of all of the hazardous or
potentially hazardous waste (Tiers 1 through 3).

. Tier 4: Total waste for Tier 4 chemicals. Tier 4 chemicals are a few relatively
innocuous compounds that pose little or no risk of harm under normal usage
conditions. Examples are water, sodium chloride, and nitrogen.

The percent of waste generated in each tier, relative to the production volume, is shown to the right
of the tier buttons on the summary screen.

> To Print SMART Summary Data

Click on the Print button.
> To View the List of Chemicals in Each Tier

To view the list of the chemicals for the present reaction that are in each tier, click on the
button for that tier. In the example above, there is no Tier 3 or Tier 4 waste, and therefore, the
buttons appear grey and are inactive. As an example, the Tier 1 Summary Screen for Sample 1
appears in Figure 21.
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Tier 1 Summary
Id: Sample 1 Anrmial Production Wobime (kegs) @ 15,000
Tier 1 total anrmal armonant charged or produced: 2,852
C4S | Chemical | Rale | Waste | Waste (Kgs| EPA Reg,
NO00075-44-5 Cathome dichlorde Feedstack 1522 197840 Yes
Total Waste : 1522 % 197840 kes
Details 0K Print

Figure 21: Tier 1 Summary Screen

To View the Total Waste Summary
To view this summary, click on the Total button on the SMART Assessment Summary

Reaction Summary

|d: Sample 1 Armal Production Vohame (kgsd ;0 13,000
CAS [ Chemical | Role | %4 Waste | Waste (Kgs| EPd Reg,
0001058-22-3 Benzene, methyl- Solvent 3077 4000.00 Wes
000075-04-7 Ethanamine Feedstock  27.75 360760 Yes
000080-05-7  Phenol, 4,4°-(1-methylethylié Feedstock 0000 0.40 Tes
000075-44-5 Carbonic dichloride Feedstock 1522 197840 Ves
Product Product Product 1398 121200 Ho
007647-01-0 Hydrochloric acid Coproduct 44 87 SB3360  Yes

Total Waste : 13260 % 1723200 ks
Details oK Print

Figure 22: Total Waste Summary Screen
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screen. The Total Waste Screen appears in Figure 22. It includes all the chemicals in the reaction,
including Tier 4.
> To View the EPA Regulated Chemicals in the Reaction
Click on EPA Regulated to view a list of all the chemicals in the reaction that are regulated under
the lists mentioned above (EPCRA sections 302 and 313, Clean Air Act section 112(r), and the
Hazardous Air Pollutants). If there are no chemicals from these lists in the reaction, this button
will appear grey and be inactive. The screen looks similar to the summaries shown in Figures 21
and 22.
> For more information about any chemical

For more information on a particular chemical, either double-click on the chemical of
interest or select it and click on Details from a summary screen. A new screen will be displayed
summarizing the amounts charged/formed, the amount recovered, and the amount of waste (see
Figure 23). If a chemical is not in the Lookup Table, the system will not be able to provide
information about EPA regulations. In this case, you will see a warning message and the check
boxes for the regulatory lists will be grey. For this screen and all the other output screens in the
SMART module, click on OK to close the screen and return to the previous screen.

1D: [M Role: |Feed$tack

HName: |Ear|:u:-niu: dichloride
SHILES: |EI=E[I:I]I:I
Molecular wWeight: |E|B. 92

Hegulated under:
EPCRA 302- ¥ EPCRA 313 ¥ caatlizp): K Haps: X

Batch Data

Quantity [kgs): [4346.00

kmol: IEEI. oo
Equivalents: |2 0K
Recovered [kgs]: |0

Percent Waste: |1 522

Annual Data

Print

Waste [kgzs]: |1EI?8.4EI

Figure 23: Detail Screen

> To Use the Green Suggestions Button

The Green Suggestions button on the SMART Assessment Summary Screen (Figure 20)
will become active when hazardous chemicals are used or formed in a chemical process. For the
current version of the GCES, this button is activated when Tier 1 or Tier 2 chemicals are present.
If this button is active, you may click on it to see the Green Suggestions Screen (Figure 25). A
ball and text appear directing you to other GCES modules. After completing the SMART
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After you have completed the SMART review of your process,
look for information in the modules suggested below:

See the Green Synthesis module. *row may be able to find an
alkernative to this synthetic method.

See the Green Solventz/Reaction Condition: madule. 'ou may be
ahle to find an alternative to the salvent uzed in thiz process.

See the Desighing Safer Chemicalz module. “rou may be able o
find infarmation on how ta reduce the toxicty of the praduct.

Figure 25: Green Suggestions Screen

assessment, check the suggested modules. You may be able to find relevant information leading to
a green alternative to your process, reaction conditions, or product.
> To Estimate the Hazard of the Chemical Process

An estimate of the hazardous nature of the chemical process can be viewed by clicking on
Level of Concern on the SMART Assessment Screen (Figure 20). A screen will be displayed

Level of Concern

The goal of Pollutien Prevention 1s to reduce or elimmate the use and generation of
hazardous substances. If any of the levels of concern are bulleted, efforts should be
tnade to reduce or elirmnate the substances(s) leading to this concern.

= | Tier1 chemicals are either used or produced. High
<+ | Chemicals on the EPCRA, CAA 112(1), or HAPS lists ate present.
- Significant quantities of tier 2 chemicals ate present as waste.
<= | Bignificant quantities of tier | + tier 2 + tier 3 chemicals are present as waste.

Significant quantities of tier 3 chemicals ate present as waste. &+
<% | Excessive total waste is present. Low

| oK ]

Figure 24: Level of Concern Screen
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showing a standard list of opportunities for pollution prevention (P2), listed in order of descending
level of concern (Figure 24). A ball marker is displayed to the left of each concern if it applies to
the particular chemical process used for this SMART Assessment. Although it is true that the
concerns are ranked, it should always be noted that if any concern exists, there may be an
opportunity for source reduction or other pollution prevention. A process that triggers only the
concerns at the bottom of the list should not be regarded as benign just because none of the higher
concerns are present. In the Sample 1 reaction (Figure 10), the concerns are:

. A Tier 1 chemical (phosgene) is used;

. EPA regulated chemicals (phosgene, toluene, bisphenol A, ethyl amine) are used;

. High levels of Tier 2 waste (toluene, bisphenol A, ethyl amine, HCI, product) are
present;

. High levels of Tier 1 + Tier 2 + Tier 3 (phosgene, toluene, bisphenol A, ethyl
amine, HCI, product) waste are present; and

. The total waste is excessive.

Now that you have identified the sources of concern, you can begin to develop strategies for
eliminating or reducing them. EPA strongly encourages replacement of hazardous chemicals with
less toxic alternatives wherever possible. In this sample case, possible suggestions might be:

. Replace phosgene with dimethyl carbonate, which has been used commercially as a
substitute for phosgene. This removes the concern for Tier 1 chemicals and reduces
the use of a regulated chemical. References to this process can be found in the
Green Synthetic Reactions module of the GCES; and

. Eliminate the use of the solvent, toluene. If a solvent is necessary, find a less toxic
replacement. This reduces both the concern for Tier 2 chemicals and the total
amount of chemicals subject to EPA regulation. A less hazardous substitute solvent
may be found by comparing the physicochemical properties of toluene with
potential alternatives in the Green Solvents/Reaction Conditions Database module
of the GCES or in other literature sources.

Sometimes there may not be a green alternative or the available alternative is not feasible.
In these cases, it may be possible to recover excess chemicals. In this example, some recovery
suggestions are:

. Recover more of the product. This would reduce the amount of Tier 2 waste; and

. Recover more of the toluene if an alternative solvent is not available. This would
reduce the amount of Tier 2 waste, and ultimately, the net amount of EPA regulated
chemicals used in the process.

Finally, some unrecoverable feedstocks may be used in a large excess. If there is no
suitable alternative feedstock available, then it may be possible to limit the excess amount to the
absolute minimum necessary for an acceptable yield. For example, if ethanamine cannot be
replaced, then you may be able to limit the excess used. Ethanamine waste amounts to 27% of the
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production volume in this sample synthesis. In practice, such a large excess of ethanamine is used
to consume HCI generated in the reaction. Perhaps this can be limited to stoichiometric amounts.
This would be true if a replacement for phosgene could be found, eliminating the need for
consuming HCI.

When you have finished viewing all of the information, click on OK until you return to the
Chemical Summary Screen (Figure 13). At this point, you can save this chemical process (if you
have not already done so) and then make changes to the input data to test one or more scenarios to
reduce the amount of waste in the reaction.

The SMART module thus offers you an opportunity to identify some of the environmental
concerns directly associated with the manufacturing process for a specific chemical product.
There are, however, other environmental concerns that are not at all addressed by the SMART
process because they are indirect results of the manufacturing process. For example, a clean
process that requires significant heating, supplied by a large oil burner, may not be free of
environmental concerns, even if the chemistry of the reaction is benign. Using the SMART
module and any knowledge that you may have about indirect environmental effects, you can
quickly evaluate a variety of alternative chemical processes and compare the results against the
original process. This allows you to identify a process with less environmental impact. The
SMART module can, therefore, be used as an effective tool for evaluating cleaner chemical
processes.

5. Additional Information: Error Messages

The SMART module performs checks to find most data entry errors. For example, assume
that the amount of carbonic dichloride recovered in Sample 1 (Figure 11) was originally entered as
1,000 kg per batch. You can simulate this error using the Sample 1 data by double-clicking on
carbonic dichloride in the Chemical Summary Screen (Figure 13), editing the amount recovered to
read 1,000 kg, selecting Continue, and then selecting SMART, Perform Assessment. An error
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message, shown in Figure 26, appears. This message tells you where the data entry error likely
occurred as well as the magnitude of the error. Click on OK to go back to Chemical Summary
Screen (Figure 13). You can then review the data on the Chemical Information Screen (Figure 15)
for carbonic dichloride and correct the error. In this case, reducing the amount recovered by at
least 10.8 kg/batch or increasing the amount of carbonic dichloride used in the reaction could
eliminate the error. Please note that the SMART module is an estimation tool and that the
algorithm ignores errors less than one percent of the batch volume. It is possible that your data
will appear to be correct even though the preceding error message appears. Adjust the amounts
charged or recovered to correct the error.

Another possible error may occur if the calculated yield of the reaction exceeds 100%.
This may occur if the amount of product formed in the reaction is too high, if the amount of
feedstock or reagent charged is too low, if the amount of feedstock recovered is too high, or if
there is a rounding error. You can simulate this error using the Sample 1 reaction data and

Data Entry Error

A data entry error was found

The calculated wield for this reaction is
107.9721 %

Possible causes include:

Q The amount of product formed is too high —
The feedstock or reagent amount is too low E
The amount of feedstock recovered is too high.
or

A rounding error has occured.

Please check the reaction and try again

Figure 27: Error Message: Yield>100%
0K

Figure 26: Error Message Screen: Excess Chemical Recovered

changing the Quantity Produced and Quantity Recovered for the product (Figure 15) to 8,000 Kg
and running the SMART assessment. Figure 27 illustrates this error.

If you see this error message during a SMART assessment, you should check each of the
possible causes listed on the screen. Clicking on OK will take you back to the Chemical Summary
Screen (Figure 13), from which you may correct the error.

The Chemical Information Screen (Figure 15) allows you to change the CAS
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The ID haz changed. Overwrite? E3

Select ""vYes" to look up the chemical
and overwrite existing data with the
new Name, MY, and SMILES

Select "No' to change the ID but not the Name,
MY, or SMILES

The quantity. role, quantity recovered, and
equivalents will not change as a result of this
action.

No Cancel

Figure 28: Chemical ID Change Prompt Screen

RN/identifying number, molecular weight, SMILES notation, and chemical name. If you change
the ID number, (for example, from 108-88-3 for toluene to 108-38-3 for m-xylene), a prompt will
appear (Figure 28) when you click outside of the ID box. Selecting Yes will look up the data for
the new ID and overwrite the name, molecular weight and SMILES notation. Use this option if
you want to change the chemical used in the reaction and replace it with another (e.g., changing
the toluene solvent in the Sample 1 reaction to m-xylene). Select No if you simply want to change
the chemical 1D when, for example, an Other Unique Identifier was used initially and a CAS RN
was found later. In this case, the system will only change the chemical ID.

You may also correct the SMILES notation. Make the necessary changes to the SMILES
notation. When you click in another box, you will be prompted to confirm the change. You can
change the Name and MW in this manner, but you will not be prompted for confirmation.

The quantity, quantity recovered, role, and equivalents fields can be changed at any time.
After you return to the Chemical Summary Screen (Figure 13) and select SMART, Perform
Assessment, the results will reflect the changes you made.
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B. Green Synthetic Reactions
1. Description of the Module

The Green Synthetic Reactions module is a database containing current references related
to selected synthetic processes. In the current version of the GCES, this module contains only
limited references; it is planned for expansion in future versions. The processes in the Green
Synthetic Reactions module have been chosen as examples of green chemistry alternatives to
replace conventional industrial syntheses. The user can search the database in any of the following
fields: pollution prevention comments (e.g., safety or inexpensive), key word(s), status (e.g., lab
scale, pilot plant, or patent), or reference. Results are presented on a form that contains the full
reference citation(s), a description of the reaction, vendors, the status, and comments on the
advantages of using each process for pollution prevention.

Welcome to the GCES

Green Synthetic Reactions Module

This module provides information on greener synthetic
methods.

iSearch the Database

Return to Main Menu

Figure 29: Green Synthetic Reactions Main Screen
2. Searching the Module

When you choose the Green Synthetic Reactions module from the main menu, you will be
given the choice (Figure 29) to search the database or return to the Main Screen. If you choose
Search the Database, you will see the Green Synthetic Reactions Search Screen (Figure 30).
Simply enter the appropriate search specifications and click on Perform Search. You may narrow
your search by combining terms with the search operators (or, and) on the bottom of the screen.
Please note that these operators only work when combined between different search fields. For
example, you may search for “nitrile” in the key word field and “Smith” in the reference field.
However, you cannot search for “Smith” or “Jones” in the reference field. An asterisk (*) alone in
any of the fields will return all of the records in the database. Note that key words must match the
wording in the citation exactly and thus you may obtain the best search results by keeping your
search criteria as broad as possible. You can use word fragments to broaden your search. For
example searching “acet” in the key word field will match “acetyl”, “acetic”, “acetate”, and
“acetone”.
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Enter your search term(s) for any (or all) of the following fields:

Fallution Prevention
Comments:

K.en word[=]

Statuz |

Reference: |

Search operator. @ Or () And iSearch; ”Cluse Module

........................

Figure 30: Green Synthetic Reactions Search Screen

The current version of the GCES utilizes a simple search engine that queries the entire
database. Sequential searches of intermediate record sets (data subsets) are not possible, although
you can obtain the required information by the careful selection of search terms. Please note that
superscripts and subscripts are not used in this module; for example, CH,OH is represented as
CH3O0H. Searches in the Green Synthetic Reactions module may include (but are not limited to)
some of the common terms for selected fields provided below:

Key words

acid catalyst oxidation
alcohol catalytic phosgene-free
amide chloride process
amidocarbonylation chlorine-free 1,3-propanediol
amine DMC rearrangement
anhydride enzymatic styrene
aromatic hydrolysis supercritical
bromination isocyanate THF

carbon dioxide methyl urethanes
carbonylation NMP water

Pollution Prevention Comments

acetic bromination conventional
acetone byproduct coproduct
acid carbon DMC
alcohols carbonylation eliminate
aldehyde catalysis ethylene
alkyl catalyst feedstock
alternative CH30OH formation
amine chlorine HCI
ammonium Cl+ HCN
anhydride concern HF

aromatic conditions HNO3-H2S04
arylation convenient hypochlorite
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inexpensive propylene

intermediate pure

isocyanate reaction

ketones reacts

liquid reagents

nitration recycled

non-acidic removed

non-toxic route

oxidation safety

phosgene salt

process SC-CO2

produce secondary
sodium
solvent
source
styrene
sulfate
sulfuric
supercritical
system
traditional
waste
water
yield

Status

commercial

commercially

lab

new

patent

pilot

plant

produce

production

R&D

scale

u.S.

Reference (Note that titles of articles are included, but that not all articles
actually have titles. )

1992 Joseph News

Encyclopedia market Science

31



Sheldon
May

3. Viewing the Search Results

The search results will be displayed on a form on the screen. Click on the Print button if
you wish to print the entire list of matches. You can view each record in the query results by
clicking on the outside arrow keys at the bottom of the screen to take you to the top () or
bottom ([21) of the list or clicking on the inside arrow keys to take you up (%) or down ( 21)
the list one record at a time. If it appears that the text does not fit in one of the text boxes,
simply double-clicking in that text box will allow you to read all of the text contained inside. An
example of a search using “phosgene” is shown in Figure 31. The GCES had twenty five
citations that met the search criteria. You may print either the record shown or the entire list
using the Print Entry or Print List buttons.

When you have completed your search, you can choose to Perform Another Search or
exit the Green Synthetic Reactions module by clicking on the Close Module button or by
selecting File, Close Module from the menu at the top of the screen. If no records were found to
match your search criteria, your criteria may have been too specific. In this case, you may want
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to click on Perform Another Search and broaden the search terms used. However, the limited
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Green Synthetic Reactions Search Results

]D:I 29 Allenative: [¥es Conventional: [Hao

Rgﬂemm:e:ll:l CA 1092317907, Yagn, T. et. al., "Mamifacture of isocyanates
without phosgene", PCT Int. Appl., 1988, Japan patent to Daicel
Chemieal Todnstres W0 BROSAE0 AT BROTIE 2 6 1215071575

Key wu:ﬂs:lphnsgene-f'ree process to dusocyanate Dimethyl cathonate (DRIC]

P? Comments:|Conventional route uses phosgene and generate HCL. This process is
a phosgene-fres process.

Status:IR & I, Patent WO 8805450 &1 880728

Vendor: IDa.i.cel Chemical Industries, Ltd.

:Perform_Another Search: I Close Module Print Entry | [ Print List

M| 4 | Record:|1

Figure 31: Green Synthetic Reactions Search Results Screen

size of the database in this version of the GCES may mean that this module simply does not
contain the reference you are looking for. For example, at present, there is no information on
chromium replacements in this module. The amount of information that the GCES can index is
limited and a library search may be necessary. However, you may check
www.epa.gov/greenchemistry to see if an update to the GCES is available.
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C. Designing Safer Chemicals
1. Description of the Module

The Designing Safer Chemicals module provides you with qualitative information
regarding the toxicities of compounds within certain chemical classes or that have certain uses.
Based on structure-activity relationships, this module will help you to estimate the qualitative
toxicity of a particular chemical in the classes covered, to understand their mechanism of
toxicity, and to predict which structural modifications that may reduce how hazardous a
compound is. Information is organized by class or use, or, in the case of environmental toxicity,
by chemical characteristic. This module is intended to be used as a tool for assessing relative
toxicities of chemicals so that you may easily consider toxicity as a factor when choosing or
designing chemicals for a process. The current version of the GCES provides information on
designing safer chemicals in a variety of classes and contains a limited number of examples of
Designing Safer Chemicals. More examples will be added in future versions. You may check
www.epa.gov/greenchemistry for updates.

Welcome to the GCES

Designing Safer Chemicals Module

Thiz module provides gudance onhow safer chemdcal substances can be designed. You
caty either search the reference section ot look for information based on Chemical Class,
Chemical Characteristic, or Cheical Use.

Search Examples Chemical Classes

Chemical Characteristics

iBeturn to Main Menu: Chemical Use

Figure 32: Designing Safer Chemicals Main Screen

2. Using the Module

From the main menu, choose one of the section buttons. In this version, information is
limited to chemical classes, links to characteristic estimation software, and some searchable
examples. Select the section of choice by clicking on it or by choosing the section from the
Designing Safer Chemicals menu in the menu bar at the top of the screen.
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Selecting Chemical Classes will bring up screen that lists the major classes for which
information is available. Click on a topic to select it and open up a sub-program that behaves
like standard Windows™ on-line help. Within this sub-program, you have a number of options
available for navigating and printing the class-specific information. You can print a topic screen
by choosing the Print button or File, Print Topic from the menu bar at the top of the text screen.
To re-read a previous screen, you may click on the Back button. Depending on how many times
the Back button is pushed, this function will bring you all the way back to the initial screen for
the topic you chose under a specific chemical class. In addition, you may view a history of the
pages you have visited by choosing the History button from the top menu bar (Windows 95
users should select Options, Display History Window). Double-clicking on any title listed in
the history will bring up that page. You can also access information on the other topics within
the chemical class by clicking on the Contents button.

To return to the GCES Main Screen, close the sub-program by selecting Exit from the
File menu. Alternatively, you may use any of the standard Windows™ short cuts.

The Chemical Characteristics section of Designing Safer Chemicals has links to other
software that allow you to estimate some of the characteristics of chemicals. See section 5 below
for more information on using these links.

3. Example: Nitriles

Choosing nitriles from the list of chemical classes brings up the Nitriles Screen (Figure
33). You may review any of the listed topics by clicking on the corresponding buttons.

Mitriles are substanices that contain the cyano (CH) group. Hitriles represent a large
commercial category of chemical substances that include (among others) dag products,
solvents, and synthetic intermediates. ¥While a variety of toxic effects have been reported
fot specific nitriles, the two major toxic cotcerns for this chemical class ate acute lethality
atid osteolaythrism. A comprehensive discussion of nitrile toxicity and how safer nitriles
cati be designed is available (DeVito, Stephen C.; Designing Bafer Mitriles. IN Designing
Hafer Chemicals, Green Chemistry for Pollution Prevention, DeVito, 3.C. and Garrett, RL,
Editors, ACS Symposivan Series Mo, 640, American Chemical Society, Washington, TIC, 1996,
pages 194223

Toxic mechanisms and structure-activity relationships of nitrile tuxi[:itvll

Qualitative toxicity assessment of a planned nitrile

Guidance for designing safer nitriles

Figure 33: Nitriles Screen
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The Toxic mechanisms and structure-activity relationships of nitrile toxicity button
brings up a topic page that displays information on the toxicity and structure-activity
relationships for toxic responses. This page has further links to other screens containing
additional toxicity information. The Qualitative toxicity assessment of a planned nitrile

Polymers

Introduction

[Polymers Excluded from the Polymer Exemption Rule] I

Eligihility Criteria for Polymers not Specifically Excluded

Designing Safer Polymers

Figure 34: Polymers Screen

button brings up a series of questions designed to determine the acute lethality or osteolathyrism
of a particular nitrile, based on structure-activity relationships. The descriptions in this section
have two hyper-links to related subjects in the Guidance for designing safer nitriles section to
enable you to recognize and avoid nitriles that are known to cause acute lethality or
osteolathyrism. It also suggests how to design nitriles that are less toxic. The Guidance for
designing safer nitriles button brings up a text screen describing structural modifications that
are expected to reduce nitrile toxicity. You may access other pages within this sub-program by
clicking on the green text highlighted with underlines.

4. Example: Polymers

The polymers sub-program was designed to highlight those chemical characteristics
common to polymers that may pose an unreasonable risk to human health or the environment.
You may view any of the listed topics on the Polymers Screen (Figure 34) by clicking on the
corresponding button.

The Introduction contains a brief discussion of how EPA reviews polymers under section 5 of
TSCA (Toxic Substances Control Act; under section 5, the Agency reviews Premanufacture
Notifications [PMNs] for New Chemical Substances). Note that although much of the
information in this module is derived from the Agency’s review of new polymers, the
information is applicable to both new and existing polymers. Polymers excluded from the
Polymer Exemption Rule provides detailed discussions on new polymers that are subject to full
PMN review (i.e., are excluded from the polymer exemption rule to PMN reporting ) because of
their potential for adverse effects. The Eligibility Criteria for Polymers not Specifically
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Excluded discusses the three classes of polymers eligible for a polymer exemption filing:

. those with a number-average molecular weight greater than or equal to 1,000
daltons and less than 10,000 daltons, low reactivity, and low oligomeric content
(designated el polymers by the exemption rule);

. those with a number-average molecular weight greater than 10,000 daltons and
lower oligomeric content (designated e2 polymers); and

. polyesters made from specified feedstocks (designated e3 polymers).

Designing Safer Polymers leads you through an algorithm to determine whether a polymer is
eligible for the polymer exemption rule and to determine the relative toxicity of a polymer based
on its composition and physicochemical properties. You can also view the entire algorithm on a

> Dezigning Safer Chemicals - Polymers

File Edit Bookmark Ophons Help

Contents| Search | Back Frint

Safer polymer algorithm ﬂ

(1) The polymer 15 cationic or potentially cation. Yes Mo
If Ves proceed; f Mo Go To (3)

(2) The combined, catiomc FGEW 1z 2 5,000, Yes No
Tes proceed;, f Mo Go To (22)

(2 OfC, H, M, O, 5, and 51, two elements are mtegral  Yes Mo
If Ves proceed; £ Mo Go To (22)

{4 Halogens are absent from the polymer. Tes Mo
IfYes Go To (), f Mo proceed

(5) Halogens are only cowvalently bound to O Tes Mo
IF¥es GoTo (), £ Mo proceed

(&) Halogens are only monatormic antons, Cl-, Br-, or I-;, and no

fuoride aron (F-) s present. Tes Mo =]

Figure 35: Designing Safer Polymers One-Page Summary Screen

single page (Figure 35).
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The two possible outcomes of the analysis are:

. The polymer being manufactured is safer than many other polymers and may
qualify for the polymer exemption from TSCA Section 5 reporting requirements
for new chemicals. (If the polymer decomposes, degrades, or depolymerizes, it
may not qualify for the polymer exemption.) Further information regarding the
Polymer Exemption Rule, a Technical Guidance Manual for the exemption, and
the Chemistry Assistance Manual for Premanufacture Notices can be obtained
from the TSCA Hotline at (202) 554-1404. or

. The polymer does not qualify for the polymer exemption. You may be able to
develop a safer alternative that satisfies the conditions of the polymer exemption
rule. Use the guidelines in this module to identify an alternative that both retains
its manufacturing specifications and meets the requirements of the polymer
exemption. As you progress through the algorithm, whenever a yes/no choice
you have made produces a “does not qualify” result, push the Back button and
examine what disqualified the polymer from exemption

The other Chemical Classes are set up in a similar format. To exit the Designing Safer
Chemicals module and return to the GCES Main Screen, click on File, Close Module.

5. Chemical Characteristics: Linking Estimation Software

If you have EPA estimation software for bioaccumulation (bcfwin), biodegradation
(biowin), or aquatic toxicity (ecowin), you may link the GCES to these programs to simplify
your work in developing a safer chemical. Select Preferences from the File menu. Fill in the
paths for any or all of the tools that are installed on your computer. You may then launch the
tools from the Chemical Characteristics section of the Designing Safer Chemicals Module by
clicking on the appropriate button.

These programs are available from the EPA directly at the addresses below or from
Syracuse Research Corporation (esc.syrres.com/~escl/estsoft.htm). Questions about these
products should be directed to:

Ecowin:
Vince Nabholz
New Chemicals Screening and Assessment Branch (7403)
US Environmental Protection Agency
401 M St. SW
Washington, DC, 20460
nabholz.joe@epa.gov

BCFwin and Biowin:
Bob Boethling
Exposure Assessment Branch (7406)
US Environmental Protection Agency
401 M St. SW
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Washington, DC, 20460
boethling.bob@epa.gov
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D. Green Solvents/Reaction Conditions
1. Description of the Module

The Green Solvents/Reaction Conditions module provides information on green reaction
conditions as well as databases of examples and physicochemical properties for over 600
solvents, of varying hazard, many of which are commonly used. Learn more about the state of
the science by browsing the Green Solvents/Reaction Conditions. Find replacement solvents by
searching for solvents that approximate the set of properties of the solvent you would like to
replace. The GCES does not contain toxicity data for these solvents, but does contain regulatory
list information, in addition to global warming potential and ozone depletion potential. Using
this information, you may qualitatively evaluate health and environmental hazards. For a more
quantitative hazard evaluation, you should determine the toxicity of solvents by other means
after identifying alternatives through this module. In the current version of the GCES, this
module contains a limited number of examples; more will be added in future versions.

Green Solvents/Reaction Conditions
Module

This module provides information on greener solvent systems. Learn
more about green solvent systems, search for a replacement solvent

hased on physiochernical properties, hrowse the solvent databaze, or

search a datahase of examples.

{Green Solvents/Reaction Conditions)

Search Solvents by Physiochemical Properties

Browse Solvents Database

| Search Examples

| Return to Main Menu

Figure 36: Green Solvents/Reaction Conditions Main Screen
2. Using the Module

When you select the Green Solvents/Reaction Conditions module from the main menu,
you will be given a choice of reading about green solvents and reaction conditions, searching by
physical and chemical properties, browsing the solvents database, searching examples, or
returning to the GCES main menu (Figure 36). Clicking on Green Solvents/ Reaction
Conditions will bring up a list of alternative solvent systems. Click on any of the entries in the
list to learn more about each topic. This portion of the module functions similarly to the
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chemical classes in the Designing Safer Chemicals module. If you click on Browse Solvents

m Formaldehsrde
NO0056-23-5 Ilethane, tetrachloro-
N00056-1-5 GLYCERCOL
000057-55-6 FPropylene glycol
0000&0-00-4 Ethylenediaminetetraacetic acid
N00080-25-7 Ethyl ether
N00080-35-5 ACETAMIDE
NO0062-53-3 AMWILIME
N00062-75-9 H-Witrosodimethylamine
N000&4-17-5 Ethanol
Q000841 E-& Fottrde acid
O0ANAS-19-7F A petie acid
Hlilﬂecnrd:h ||:|f E49 [ 1]
| View Data Return to Previous Menu

Figure 37: Browse Solvents Database Screen

Database, you will see a screen containing the list of all of the solvents in the database in CAS
RN order (Figure 37). To scroll through the list of solvents, use the navigation arrow keys at the
bottom of the list of chemicals to take you to the top ((*]) or bottom () of the list and the
inside arrow keys to take you up (1) or down (1) the list one chemical at a time. To view the
available data for a particular chemical, select the chemical by double-clicking on it (in either the
CAS RN or name field) or by selecting a record and choosing the View Data button. See section
3 below for more information on how to search by CAS RN or name.

The information supplied for each chemical includes (when available) (see Figure 38):

. molecular weight;

. boiling point;

. melting point;

. specific gravity;

. vapor pressure;

. water solubility;

. log octanol/water partition coefficient;
. Henry’s Law constant;

. flash point;

. explosion limits;

. dielectric constant;

. ozone depletion potential;

. global warming potential (more information on global warming potential is

available by clicking on the About GWP button); and
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|000057-55-6 [Propylene glycol

Molecular Weight: [76.11 Water Solubility (mg/kg): [1000000

Boiling Point (°C): [188.2 Dielectric Constant: [32

Melting Point (°C;:[60 log OctanolWater Partition Coefficient: [0.92

Specific Gravity: W Vapor Pressure (mm Ha): 0133 @25  C

FlashPoint (°C): [95.88  Henry's Law Constant (atm/cu-mimole): [1.74E-07
Explosion Limits (%): [2.6 -[12.6

RTECS #: |TY 2000000
Ozone Depletion Potential: |

Global Warming Potential: |
EPA Regulationsz:

HAPS: [T EPCRA 302: [T EPCRA313: [ CAATI2(n0: [

| aboutEPARegs | |  About GwP

Figure 38: Physiochemical Properties Screen

. EPA Regulations (more information about these lists is available by clicking on
the About EPA Regs button).

After reviewing the data, click on OK to return to the list of solvents.

3. Searching the Solvent Database

After selecting Search Solvents by Physiochemical Properties from the Solvent
Database Main Screen, enter any combination of boiling point range, melting point range and/or
a water solubility range (Figure 39). If you enter more than one range, the module will search

Search for solvent with:

BP between: | and | “C
and MP between: | and | o
and Water Solubility between: | and | mg./Kg

| search | |Can-::e|

Figure 39: Physical/Chemical Property Search Screen
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for a solvent with properties in all the entered ranges. The solvents are displayed with their full
set of data. Use the navigation arrows at the bottom of the screen to view the solvents matching
the search criteria. You may print the data for the displayed solvent by clicking on the Print
button. Select Return to Previous Menu to return to the Green Solvents/Reaction Conditions
Main Screen

You may also search in Browse Solvents Database Screen (Figure 37) using the
Microsoft Access® search function. If you are looking for a particular solvent, you may use
Search, Search Database from the menu bar in the upper left corner. This search method is
useful when you are looking for a specific chemical by CAS RN or chemical name (or part
thereof). Microsoft Access® users will recognize this screen as the usual Access® “Find”
command. Before selecting this menu item, identify the search field by clicking in either the
CAS RN or the chemical name field in the Browse Solvents Database Screen (Figure 37). Thus,
if you click in the chemical name field and select Search, Search Database from the menu, the
system will perform a chemical name search. Similarly, you can conduct a CAS RN search by
clicking in the CAS RN field before you select Search, Search Database. The search command
brings up the Microsoft Access ® Search Screen (Figure 40). You may find it helpful to move
the Search Screen so that it does not obscure you view of the list of solvents.

Find in field: "Chemical Hame"

Find What: |chloro Find First |
Where: IAny Part of Field jJ PR
Search In ' Up

[ ® Cument Field O All Fields (& Down E.

[T Match Caze [T S5earch Fields az Formatted:

Figure 40: Microsoft Access® Search Screen

. Find What - Type the alphanumeric search string you want to find, either a CAS
RN or a chemical name. You may type either the full search term or only a small
part (i.e., a sub-string) based on the choice of the Where setting;

. Where - This can be used to perform a full name or sub-string search. Click the
drop-down arrow to display a list of search locations: Any Part of Field (e.g., the
results of searching for “chloro” will include both dichlorodifluoromethane and
methane, tetrachloro); Match Whole Field will provide an exact match; and Start
of Field will search for the text string at the beginning of a field;

. Search In - The default setting is Current Field. Either setting is acceptable.

. Direction - This provides the direction of the search and is typically left in the
default setting, Down, which searches from the top of the list towards the last
record (the Up setting can be used to re-find a previous record);
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. Match Case - This check box indicates if the search will be match upper and
lower cases (when checked) or not;

. Search Fields as Formatted - Select this option to find data based on its display
format;

. Find First - Use this to find the first occurrence of the text string in the database;

. Find Next - Use this function to find the next occurrence (relative to the cursor);
you may repeat this function until the last occurrence of the text string is reached:;
and

. Close - This button closes the Find feature and leaves the cursor on the selected
solvent.

Sometimes matches are found, but the highlighted text is hidden behind the Search Screen. In
this case, simply click on the blue bar at the top of the Search Screen and drag it out of the way.
If you get no hits for your search, check to be sure you searched in the correct field. After
completing a search, click on Close to exit the search screen. When you are finished viewing or
printing the data in the Solvent Database module, select File, Close Form or the Close Form
button from the menu to return to the module’s opening screen. Selecting the Return to Main
Screen button or File, Close Module menu item will return you to the main screen of the GCES.
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E. Green Chemistry References
1. Description of the Module

This module includes references to material published in green chemistry and related
fields. To proceed with a search, click on the Search References button (Figure 41). The
search function of this module is similar to that used in the Green Synthetic Reactions module.
You may want to refer to Section VI. B. of this manual for detailed instructions on its use.

2. Searching the Module

You may browse the database by category and subcategory. Select a category of interest,
with or without a subcategory, in the Green Chemistry References Search Screen (Figure 42) and
click on Perform Search. To perform a search for specific information, enter information in
any of the fields: Author, Title, Journal, or Key word. Note that at present you cannot search by
date or volume number. Some key word suggestions include (but are not limited to):

green feedstocks green chemical processing
biomass separations
renewable feedstocks extractions

purifications

green reagents analysis
photochemical reagents

process analytical chemistry

hazardous chemical reduction/elimination
bioprocessing

reduced solvent

solventless processes

waste reduction/elimination

energy efficient processes

green chemical
synthesis/manufacturing
catalysis

biocatalysis

atom economy

green solvents

aqueous conditions
derivatized/polymeric solvents
ionic liquids

supercritical solvents

designing safer chemicals
inherently safer chemicals
less toxic chemicals
biodegradable chemicals

green reaction conditions less persistent chemicals

energy efficient reactions
solventless reactions

Searches may be narrowed by combining categories, subcategories and other search terms with
the search operators (or, and) on the bottom of the window. The search results, if any, will be
displayed; multiple search results are displayed in a table format. As in the Green Synthetic
Reactions module, the search operators work only when combined across different search fields.
Further, an asterisk may be used as a “wild card” to truncate the front or back of a search term or
may be used alone in any field to return all of the references with entries in that section.
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Welcome to Green Chemistry
References Module

This module allows the user to search for additional

information on green chemistry

iSearch References;

AddfDelete References

Return to Main Menu

Figure 41: Green Chemistry References Main Screen

Select a category or enter your search term(s) for any (or all) of the
following fields:

To search all categories, leave the category box blank.

cakegaory I Iil

zubcateq

|
Authar I
Title I

Journal I

ey word(z)

Perform Search I

Searchoperator: () Or (@  And

Close Module

Figure 42: Green Chemistry References Search Screen
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The following sample screen provides an example of the results of a search for
“phosgene” in the key words field (Figure 43). You can browse the references using the
navigation keys at the bottom of the screen. You can choose to Perform Another Search, or
print the results by clicking on either the Print Entry or Print List button. When you are

finished and wish to exit this module, click on File, Close Module on the top menu bar or click
on the Done button.

Green Chemistry References Search results

Category: IGreen Chermizty

Subcategory: |general areen chemistiy references

Author: |Anastas, Paul T, Willamzon, Tracy C.

Title: |Green chemisty: an overview

Journal: |AC5 Symp. Ser.

UulumE:IEEE Pages: |1-'I? D ate: I‘Iﬂ AR

Abstract: [4& review, with 72 1efs., of the Green Chem. mowvement in the chem. industy
and itz effect on rezearch and potential industnal manufg, processesz. The
'Green Chem.' movement iz an approach to the synthesiz, procezsing, and
uze of chems that redures nzks bachomans and the ervirnnment and can

iPerform Another Searchi I | Done

Print List | Print Entry

M| A | Record:|1 af ¥ 4 L1

Figure 43: Green Chemistry References Search Results Screen

3. Adding References

You may add your own references to this module by selecting Add/Delete References
from the Green Chemistry References Main Screen (Figure 41). A screen appears allowing you
access to the user-entered portion of this database (Figure 44). Any references previously
entered will appear here. You may browse and edit these records. Click on Add New Record to
add a new, blank reference. Simply fill in the information for your reference. Be as complete as
possible to facilitate future searching. Click on Delete This Record to delete the currently-
displayed reference. Browse through the records using the navigator buttons at the bottom of the

screen. References added in this portion of the database are automatically searched during any
search of the References module.
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AddfDelete References

Figure 44: Add/Delete Reference Screen
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